
Lattice Semiconductor Corporation - LFE3-95EA-9FN672I Datasheet

Welcome to E-XFL.COM

Understanding Embedded - FPGAs (Field
Programmable Gate Array)

Embedded - FPGAs, or Field Programmable Gate Arrays,
are advanced integrated circuits that offer unparalleled
flexibility and performance for digital systems. Unlike
traditional fixed-function logic devices, FPGAs can be
programmed and reprogrammed to execute a wide array
of logical operations, enabling customized functionality
tailored to specific applications. This reprogrammability
allows developers to iterate designs quickly and implement
complex functions without the need for custom hardware.

Applications of Embedded - FPGAs

The versatility of Embedded - FPGAs makes them
indispensable in numerous fields. In telecommunications,
FPGAs are used for high-speed data processing and
network infrastructure. In the automotive industry, they
support advanced driver-assistance systems (ADAS) and
infotainment solutions. Consumer electronics benefit from
FPGAs in devices requiring high performance and
adaptability, such as smart TVs and gaming consoles.
Industrial automation relies on FPGAs for real-time control
and processing in machinery and robotics. Additionally,
FPGAs play a crucial role in aerospace and defense, where
their reliability and ability to handle complex algorithms
are essential.

Common Subcategories of Embedded -
FPGAs

Within the realm of Embedded - FPGAs, several
subcategories address different needs and applications.
General-purpose FPGAs are the most widely used, offering
a balance of performance and flexibility for a broad range
of applications. High-performance FPGAs are designed for
applications requiring exceptional speed and
computational power, such as data centers and high-
frequency trading systems. Low-power FPGAs cater to
battery-operated and portable devices where energy
efficiency is paramount. Lastly, automotive-grade FPGAs
meet the stringent standards of the automotive industry,
ensuring reliability and performance in vehicle systems.

Types of Embedded - FPGAs

Embedded - FPGAs can be classified into several types
based on their architecture and specific capabilities. SRAM-
based FPGAs are prevalent due to their high speed and
ability to support complex designs, making them suitable
for performance-critical applications. Flash-based FPGAs
offer non-volatile storage, retaining their configuration
without power and enabling faster start-up times. Antifuse-
based FPGAs provide a permanent, one-time
programmable solution, ensuring robust security and
reliability for critical systems. Each type of FPGA brings
distinct advantages, making the choice dependent on the
specific needs of the application.

Details

Product Status Not For New Designs

Number of LABs/CLBs 11500

Number of Logic Elements/Cells 92000

Total RAM Bits 4526080

Number of I/O 380

Number of Gates -

Voltage - Supply 1.14V ~ 1.26V

Mounting Type Surface Mount

Operating Temperature -40°C ~ 100°C (TJ)

Package / Case 672-BBGA

Supplier Device Package 672-FPBGA (27x27)

Purchase URL https://www.e-xfl.com/product-detail/lattice-semiconductor/lfe3-95ea-9fn672i

Email: info@E-XFL.COM Address: Room A, 16/F, Full Win Commercial Centre, 573 Nathan Road, Mongkok, Hong Kong

https://www.e-xfl.com/product/pdf/lfe3-95ea-9fn672i-4485427
https://www.e-xfl.com
https://www.e-xfl.com/product/filter/embedded-fpgas-field-programmable-gate-array
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Table 2-6. Secondary Clock Regions

Figure 2-15. LatticeECP3-70 and LatticeECP3-95 Secondary Clock Regions

Device
Number of Secondary Clock 

Regions

ECP3-17 16

ECP3-35 16

ECP3-70 20

ECP3-95 20

ECP3-150 36
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Single, Dual and Pseudo-Dual Port Modes 
In all the sysMEM RAM modes the input data and address for the ports are registered at the input of the memory 
array. The output data of the memory is optionally registered at the output. 

EBR memory supports the following forms of write behavior for single port or dual port operation: 

1. Normal – Data on the output appears only during a read cycle. During a write cycle, the data (at the current 
address) does not appear on the output. This mode is supported for all data widths. 

2. Write Through – A copy of the input data appears at the output of the same port during a write cycle. This 
mode is supported for all data widths. 

3. Read-Before-Write (EA devices only) – When new data is written, the old content of the address appears at 
the output. This mode is supported for x9, x18, and x36 data widths.

Memory Core Reset 
The memory array in the EBR utilizes latches at the A and B output ports. These latches can be reset asynchro-
nously or synchronously. RSTA and RSTB are local signals, which reset the output latches associated with Port A 
and Port B, respectively. The Global Reset (GSRN) signal can reset both ports. The output data latches and asso-
ciated resets for both ports are as shown in Figure 2-22. 

Figure 2-22. Memory Core Reset

For further information on the sysMEM EBR block, please see the list of technical documentation at the end of this 
data sheet. 

sysDSP™ Slice
The LatticeECP3 family provides an enhanced sysDSP architecture, making it ideally suited for low-cost, high-per-
formance Digital Signal Processing (DSP) applications. Typical functions used in these applications are Finite 
Impulse Response (FIR) filters, Fast Fourier Transforms (FFT) functions, Correlators, Reed-Solomon/Turbo/Convo-
lution encoders and decoders. These complex signal processing functions use similar building blocks such as mul-
tiply-adders and multiply-accumulators. 

sysDSP Slice Approach Compared to General DSP
Conventional general-purpose DSP chips typically contain one to four (Multiply and Accumulate) MAC units with 
fixed data-width multipliers; this leads to limited parallelism and limited throughput. Their throughput is increased by 
higher clock speeds. The LatticeECP3, on the other hand, has many DSP slices that support different data widths. 
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This allows designers to use highly parallel implementations of DSP functions. Designers can optimize DSP perfor-
mance vs. area by choosing appropriate levels of parallelism. Figure 2-23 compares the fully serial implementation 
to the mixed parallel and serial implementation. 

Figure 2-23. Comparison of General DSP and LatticeECP3 Approaches

LatticeECP3 sysDSP Slice Architecture Features
The LatticeECP3 sysDSP Slice has been significantly enhanced to provide functions needed for advanced pro-
cessing applications. These enhancements provide improved flexibility and resource utilization.

The LatticeECP3 sysDSP Slice supports many functions that include the following:

• Multiply (one 18 x 36, two 18 x 18 or four 9 x 9 Multiplies per Slice)

• Multiply (36 x 36 by cascading across two sysDSP slices)

• Multiply Accumulate (up to 18 x 36 Multipliers feeding an Accumulator that can have up to 54-bit resolution)

• Two Multiplies feeding one Accumulate per cycle for increased processing with lower latency (two 18 x 18 Mul-
tiplies feed into an accumulator that can accumulate up to 52 bits)

• Flexible saturation and rounding options to satisfy a diverse set of applications situations

• Flexible cascading across DSP slices
—  Minimizes fabric use for common DSP and ALU functions
—  Enables implementation of FIR Filter or similar structures using dedicated sysDSP slice resources only
—  Provides matching pipeline registers
—  Can be configured to continue cascading from one row of sysDSP slices to another for longer cascade 

chains

• Flexible and Powerful Arithmetic Logic Unit (ALU) Supports:
—  Dynamically selectable ALU OPCODE
—  Ternary arithmetic (addition/subtraction of three inputs)
—  Bit-wise two-input logic operations (AND, OR, NAND, NOR, XOR and XNOR)
—  Eight flexible and programmable ALU flags that can be used for multiple pattern detection scenarios, such 
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Figure 2-37. DQS Local Bus

Polarity Control Logic
In a typical DDR Memory interface design, the phase relationship between the incoming delayed DQS strobe and 
the internal system clock (during the READ cycle) is unknown. The LatticeECP3 family contains dedicated circuits 
to transfer data between these domains. A clock polarity selector is used to prevent set-up and hold violations at 
the domain transfer between DQS (delayed) and the system clock. This changes the edge on which the data is reg-
istered in the synchronizing registers in the input register block. This requires evaluation at the start of each READ 
cycle for the correct clock polarity. 

Prior to the READ operation in DDR memories, DQS is in tristate (pulled by termination). The DDR memory device 
drives DQS low at the start of the preamble state. A dedicated circuit detects the first DQS rising edge after the pre-
amble state. This signal is used to control the polarity of the clock to the synchronizing registers.

DDR3 Memory Support
LatticeECP3 supports the read and write leveling required for DDR3 memory interfaces.

Read leveling is supported by the use of the DDRCLKPOL and the DDRLAT signals generated in the DQS Read 
Control logic block. These signals dynamically control the capture of the data with respect to the DQS at the input 
register block. 
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2. Left and Right (Banks 2, 3, 6 and 7) sysI/O Buffer Pairs (50% Differential and 100% Single-Ended Out-
puts)
The sysI/O buffer pairs in the left and right banks of the device consist of two single-ended output drivers, two 
sets of single-ended input buffers (both ratioed and referenced) and one differential output driver. One of the 
referenced input buffers can also be configured as a differential input. In these banks the two pads in the pair 
are described as “true” and “comp”, where the true pad is associated with the positive side of the differential I/O, 
and the comp (complementary) pad is associated with the negative side of the differential I/O. 

In addition, programmable on-chip input termination (parallel or differential, static or dynamic) is supported on 
these sides, which is required for DDR3 interface. However, there is no support for hot-socketing for the I/O 
pins located on the left and right side of the device as the PCI clamp is always enabled on these pins.

LVDS, RSDS, PPLVDS and Mini-LVDS differential output drivers are available on 50% of the buffer pairs on the 
left and right banks. 

3. Configuration Bank sysI/O Buffer Pairs (Single-Ended Outputs, Only on Shared Pins When Not Used by 
Configuration)
The sysI/O buffers in the Configuration Bank consist of ratioed single-ended output drivers and single-ended 
input buffers. This bank does not support PCI clamp like the other banks on the top, left, and right sides. 

The two pads in the pair are described as “true” and “comp”, where the true pad is associated with the positive 
side of the differential input buffer and the comp (complementary) pad is associated with the negative side of 
the differential input buffer. 

Programmable PCI clamps are only available on the top banks. PCI clamps are used primarily on inputs and bi-
directional pads to reduce ringing on the receiving end.

Typical sysI/O I/O Behavior During Power-up 
The internal power-on-reset (POR) signal is deactivated when VCC, VCCIO8 and VCCAUX have reached satisfactory 
levels. After the POR signal is deactivated, the FPGA core logic becomes active. It is the user’s responsibility to 
ensure that all other VCCIO banks are active with valid input logic levels to properly control the output logic states of 
all the I/O banks that are critical to the application. For more information about controlling the output logic state with 
valid input logic levels during power-up in LatticeECP3 devices, see the list of technical documentation at the end 
of this data sheet. 

The VCC and VCCAUX supply the power to the FPGA core fabric, whereas the VCCIO supplies power to the I/O buf-
fers. In order to simplify system design while providing consistent and predictable I/O behavior, it is recommended 
that the I/O buffers be powered-up prior to the FPGA core fabric. VCCIO supplies should be powered-up before or 
together with the VCC and VCCAUX supplies. 

Supported sysI/O Standards 
The LatticeECP3 sysI/O buffer supports both single-ended and differential standards. Single-ended standards can 
be further subdivided into LVCMOS, LVTTL and other standards. The buffers support the LVTTL, LVCMOS 1.2 V, 
1.5 V, 1.8 V, 2.5 V and 3.3 V standards. In the LVCMOS and LVTTL modes, the buffer has individual configuration 
options for drive strength, slew rates, bus maintenance (weak pull-up, weak pull-down, or a bus-keeper latch) and 
open drain. Other single-ended standards supported include SSTL and HSTL. Differential standards supported 
include LVDS, BLVDS, LVPECL, MLVDS, RSDS, Mini-LVDS, PPLVDS (point-to-point LVDS), TRLVDS (Transition 
Reduced LVDS), differential SSTL and differential HSTL. For further information on utilizing the sysI/O buffer to 
support a variety of standards please see TN1177, LatticeECP3 sysIO Usage Guide. 

www.latticesemi.com/dynamic/view_document.cfm?document_id=32317
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There are some restrictions to be aware of when using spread spectrum. When a quad shares a PCI Express x1 
channel with a non-PCI Express channel, ensure that the reference clock for the quad is compatible with all proto-
cols within the quad. For example, a PCI Express spread spectrum reference clock is not compatible with most 
Gigabit Ethernet applications because of tight CTC ppm requirements.

While the LatticeECP3 architecture will allow the mixing of a PCI Express channel and a Gigabit Ethernet, Serial 
RapidIO or SGMII channel within the same quad, using a PCI Express spread spectrum clocking as the transmit 
reference clock will cause a violation of the Gigabit Ethernet, Serial RapidIO and SGMII transmit jitter specifica-
tions.

For further information on SERDES, please see TN1176, LatticeECP3 SERDES/PCS Usage Guide.

IEEE 1149.1-Compliant Boundary Scan Testability 
All LatticeECP3 devices have boundary scan cells that are accessed through an IEEE 1149.1 compliant Test 
Access Port (TAP). This allows functional testing of the circuit board on which the device is mounted through a 
serial scan path that can access all critical logic nodes. Internal registers are linked internally, allowing test data to 
be shifted in and loaded directly onto test nodes, or test data to be captured and shifted out for verification. The test 
access port consists of dedicated I/Os: TDI, TDO, TCK and TMS. The test access port has its own supply voltage 
VCCJ and can operate with LVCMOS3.3, 2.5, 1.8, 1.5 and 1.2 standards. 

For more information, please see TN1169, LatticeECP3 sysCONFIG Usage Guide.

Device Configuration 
All LatticeECP3 devices contain two ports that can be used for device configuration. The Test Access Port (TAP), 
which supports bit-wide configuration, and the sysCONFIG port, support dual-byte, byte and serial configuration. 
The TAP supports both the IEEE Standard 1149.1 Boundary Scan specification and the IEEE Standard 1532 In- 
System Configuration specification. The sysCONFIG port includes seven I/Os used as dedicated pins with the 
remaining pins used as dual-use pins. See TN1169, LatticeECP3 sysCONFIG Usage Guide for more information 
about using the dual-use pins as general purpose I/Os.

There are various ways to configure a LatticeECP3 device:

1. JTAG

2. Standard Serial Peripheral Interface (SPI and SPIm modes) - interface to boot PROM memory

3. System microprocessor to drive a x8 CPU port (PCM mode)

4. System microprocessor to drive a serial slave SPI port (SSPI mode)

5. Generic byte wide flash with a MachXO™ device, providing control and addressing

On power-up, the FPGA SRAM is ready to be configured using the selected sysCONFIG port. Once a configuration 
port is selected, it will remain active throughout that configuration cycle. The IEEE 1149.1 port can be activated any 
time after power-up by sending the appropriate command through the TAP port. 

LatticeECP3 devices also support the Slave SPI Interface. In this mode, the FPGA behaves like a SPI Flash device 
(slave mode) with the SPI port of the FPGA to perform read-write operations.

www.latticesemi.com/dynamic/view_document.cfm?document_id=32316
www.latticesemi.com/dynamic/view_document.cfm?document_id=32314
www.latticesemi.com/dynamic/view_document.cfm?document_id=32314
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BLVDS25
The LatticeECP3 devices support the BLVDS standard. This standard is emulated using complementary LVCMOS 
outputs in conjunction with a parallel external resistor across the driver outputs. BLVDS is intended for use when 
multi-drop and bi-directional multi-point differential signaling is required. The scheme shown in Figure 3-2 is one 
possible solution for bi-directional multi-point differential signals.

Figure 3-2. BLVDS25 Multi-point Output Example

Table 3-2. BLVDS25 DC Conditions1

Over Recommended Operating Conditions

Parameter Description

Typical

UnitsZo = 45 Zo = 90

VCCIO Output Driver Supply (+/– 5%) 2.50 2.50 V

ZOUT Driver Impedance 10.00 10.00 

RS Driver Series Resistor (+/– 1%) 90.00 90.00 

RTL Driver Parallel Resistor (+/– 1%) 45.00 90.00 

RTR Receiver Termination (+/– 1%) 45.00 90.00 

VOH Output High Voltage 1.38 1.48 V

VOL Output Low Voltage 1.12 1.02 V

VOD Output Differential Voltage 0.25 0.46 V

VCM Output Common Mode Voltage 1.25 1.25 V

IDC DC Output Current 11.24 10.20 mA

1. For input buffer, see LVDS table.

Heavily loaded backplane, effective Zo ~ 45 to 90 Ohms differential
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LVPECL33
The LatticeECP3 devices support the differential LVPECL standard. This standard is emulated using complemen-
tary LVCMOS outputs in conjunction with a parallel resistor across the driver outputs. The LVPECL input standard 
is supported by the LVDS differential input buffer. The scheme shown in Figure 3-3 is one possible solution for 
point-to-point signals.

Figure 3-3. Differential LVPECL33

Table 3-3. LVPECL33 DC Conditions1

Over Recommended Operating Conditions

Parameter Description Typical Units

VCCIO Output Driver Supply (+/–5%) 3.30 V

ZOUT Driver Impedance 10 

RS Driver Series Resistor (+/–1%) 93 

RP Driver Parallel Resistor (+/–1%) 196 

RT Receiver Termination (+/–1%) 100 

VOH Output High Voltage 2.05 V

VOL Output Low Voltage 1.25 V

VOD Output Differential Voltage 0.80 V

VCM Output Common Mode Voltage 1.65 V

ZBACK Back Impedance 100.5 

IDC DC Output Current 12.11 mA

1. For input buffer, see LVDS table.

Transmission line, 
Zo = 100 Ohm differential 

Off-chipOn-chip

VCCIO = 3.3 V 
(+/–5%)

VCCIO = 3.3 V 
(+/–5%)

RP = 196 Ohms 
(+/–1%)

RT = 100 Ohms 
(+/–1%)

RS = 93.1 Ohms 
(+/–1%)

RS = 93.1 Ohms 
(+/–1%)

16 mA

16 mA

+
–

Off-chip On-chip
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Generic DDRX2 Inputs with Clock and Data (>10bits wide) are Aligned at Pin (GDDRX2_RX.ECLK.Aligned)  
(No CLKDIV)

Left and Right Sides Using DLLCLKPIN for Clock Input

tDVACLKGDDR Data Setup Before CLK ECP3-150EA — 0.225 — 0.225 — 0.225 UI

tDVECLKGDDR Data Hold After CLK ECP3-150EA 0.775 — 0.775  — 0.775 — UI

fMAX_GDDR DDRX2 Clock Frequency ECP3-150EA — 460 — 385 — 345 MHz

tDVACLKGDDR Data Setup Before CLK ECP3-70EA/95EA — 0.225 — 0.225 — 0.225 UI

tDVECLKGDDR Data Hold After CLK ECP3-70EA/95EA 0.775 — 0.775  — 0.775 — UI

fMAX_GDDR DDRX2 Clock Frequency ECP3-70EA/95EA — 460 — 385 — 311 MHz

tDVACLKGDDR Data Setup Before CLK ECP3-35EA — 0.210 — 0.210 — 0.210 UI

tDVECLKGDDR Data Hold After CLK ECP3-35EA 0.790 — 0.790  — 0.790 — UI

fMAX_GDDR DDRX2 Clock Frequency ECP3-35EA — 460 — 385 — 311 MHz

tDVACLKGDDR
Data Setup Before CLK 
(Left and Right Sides) ECP3-17EA — 0.210 — 0.210 — 0.210 UI

tDVECLKGDDR Data Hold After CLK ECP3-17EA 0.790 — 0.790  — 0.790 — UI

fMAX_GDDR DDRX2 Clock Frequency ECP3-17EA — 460 — 385 — 311 MHz

Top Side Using PCLK Pin for Clock Input

tDVACLKGDDR Data Setup Before CLK ECP3-150EA — 0.225 — 0.225 — 0.225 UI

tDVECLKGDDR Data Hold After CLK ECP3-150EA 0.775 — 0.775  — 0.775 — UI

fMAX_GDDR DDRX2 Clock Frequency ECP3-150EA — 235 — 170 — 130 MHz

tDVACLKGDDR Data Setup Before CLK ECP3-70EA/95EA — 0.225 — 0.225 — 0.225 UI

tDVECLKGDDR Data Hold After CLK ECP3-70EA/95EA 0.775 — 0.775  — 0.775 — UI

fMAX_GDDR DDRX2 Clock Frequency ECP3-70EA/95EA — 235 — 170 — 130 MHz

tDVACLKGDDR Data Setup Before CLK ECP3-35EA — 0.210 — 0.210 — 0.210 UI

tDVECLKGDDR Data Hold After CLK ECP3-35EA 0.790 — 0.790  — 0.790 — UI

fMAX_GDDR DDRX2 Clock Frequency ECP3-35EA — 235 — 170 — 130 MHz

tDVACLKGDDR Data Setup Before CLK      ECP3-17EA — 0.210 — 0.210 — 0.210 UI

tDVECLKGDDR Data Hold After CLK ECP3-17EA 0.790 — 0.790  — 0.790 — UI

fMAX_GDDR DDRX2 Clock Frequency ECP3-17EA — 235 — 170 — 130 MHz

Generic DDRX2 Inputs with Clock and Data (<10 Bits Wide) Centered at Pin (GDDRX2_RX.DQS.Centered)  Using DQS Pin for Clock 
Input

Left and Right Sides

tSUGDDR Data Setup Before CLK All ECP3EA Devices 330 — 330 — 352 — ps

tHOGDDR Data Hold After CLK All ECP3EA Devices 330 — 330 — 352 — ps

fMAX_GDDR DDRX2 Clock Frequency All ECP3EA Devices — 400 — 400 — 375 MHz

Generic DDRX2 Inputs with Clock and Data (<10 Bits Wide) Aligned at Pin (GDDRX2_RX.DQS.Aligned) Using DQS Pin for Clock Input

Left and Right Sides

tDVACLKGDDR Data Setup Before CLK All ECP3EA Devices — 0.225 — 0.225 — 0.225 UI

tDVECLKGDDR Data Hold After CLK All ECP3EA Devices 0.775 — 0.775  — 0.775 — UI

fMAX_GDDR DDRX2 Clock Frequency All ECP3EA Devices — 400 — 400 — 375 MHz

Generic DDRX1 Output with Clock and Data (>10 Bits Wide) Centered at Pin (GDDRX1_TX.SCLK.Centered)10

tDVBGDDR Data Valid Before CLK ECP3-150EA 670 — 670 — 670 — ps

tDVAGDDR Data Valid After CLK ECP3-150EA 670 — 670 — 670 — ps

fMAX_GDDR DDRX1 Clock Frequency ECP3-150EA — 250 — 250 — 250 MHz

tDVBGDDR Data Valid Before CLK ECP3-70EA/95EA 666 — 665 — 664 — ps

tDVAGDDR Data Valid After CLK ECP3-70EA/95EA 666 — 665 — 664 — ps

LatticeECP3 External Switching Characteristics (Continued)1, 2, 3, 13

Over Recommended Commercial Operating Conditions

Parameter Description Device

–8 –7 –6

UnitsMin. Max. Min. Max. Min. Max.
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tHWREN_EBR Hold Write/Read Enable to EBR Memory 0.141 — 0.145 — 0.149 — ns

tSUCE_EBR
Clock Enable Setup Time to EBR Output 
Register 0.087 — 0.096 — 0.104 — ns

tHCE_EBR
Clock Enable Hold Time to EBR Output 
Register –0.066 — –0.080 — –0.094 — ns

tSUBE_EBR
Byte Enable Set-Up Time to EBR Output 
Register –0.071 — –0.070 — –0.068 — ns

tHBE_EBR
Byte Enable Hold Time to EBR Output 
Register 0.118 — 0.098 — 0.077 — ns

DSP Block Timing3

tSUI_DSP Input Register Setup Time 0.32 — 0.36 — 0.39 — ns

tHI_DSP Input Register Hold Time  –0.17 — –0.19 — –0.21 — ns

tSUP_DSP Pipeline Register Setup Time 2.23 — 2.30 — 2.37 — ns

tHP_DSP Pipeline Register Hold Time –1.02 — –1.09 — –1.15 — ns

tSUO_DSP Output Register Setup Time 3.09 — 3.22 — 3.34 — ns

tHO_DSP Output Register Hold Time –1.67 — –1.76 — –1.84 — ns

tCOI_DSP Input Register Clock to Output Time — 3.05 — 3.35 — 3.73 ns

tCOP_DSP Pipeline Register Clock to Output Time — 1.30 — 1.47 — 1.64 ns

tCOO_DSP Output Register Clock to Output Time — 0.58 — 0.60 — 0.62 ns

tSUOPT_DSP Opcode Register Setup Time 0.31 — 0.35 — 0.39 — ns

tHOPT_DSP Opcode Register Hold Time –0.20 — –0.24 — –0.27 — ns

tSUDATA_DSP
Cascade_data through ALU to Output 
Register Setup Time 1.69 — 1.94 — 2.14 — ns

tHPDATA_DSP
Cascade_data  through ALU to Output 
Register Hold Time –0.58 — –0.80 — –0.97 — ns

1. Internal parameters are characterized but not tested on every device.
2. Commercial timing numbers are shown. Industrial timing numbers are typically slower and can be extracted from the Diamond or ispLEVER 

software.
3. DSP slice is configured in Multiply Add/Sub 18 x 18 mode.
4. The output register is in Flip-flop mode.
5. For details on –9 speed grade devices, please contact your Lattice Sales Representative.

LatticeECP3 Internal Switching Characteristics1, 2, 5 (Continued)
Over Recommended Commercial Operating Conditions

Parameter Description

–8 –7 –6

Units.Min. Max. Min. Max. Min. Max.
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sysCLOCK PLL Timing
Over Recommended Operating Conditions

Parameter Descriptions Conditions Clock Min. Typ. Max. Units

fIN
Input clock frequency (CLKI, 
CLKFB)  

Edge clock 2 — 500 MHz

Primary clock4 2 — 420 MHz

fOUT
Output clock frequency (CLKOP, 
CLKOS)  

Edge clock 4 — 500 MHz

Primary clock4 4 — 420 MHz

fOUT1 K-Divider output frequency CLKOK 0.03125 — 250 MHz

fOUT2 K2-Divider output frequency CLKOK2 0.667 — 166 MHz

fVCO PLL VCO frequency  500 — 1000 MHz

fPFD
3 Phase detector input frequency  Edge clock 2 — 500 MHz

Primary clock4 2 — 420 MHz

AC Characteristics

tPA Programmable delay unit  65 130 260 ps

tDT
Output clock duty cycle 
(CLKOS, at 50% setting)

Edge clock 45 50 55 %

fOUT 250 MHz Primary clock 45 50 55 %

fOUT > 250 MHz Primary clock 30 50 70 %

tCPA
Coarse phase shift error 
(CLKOS, at all settings)  -5 0 +5 % of 

period

tOPW

Output clock pulse width high or 
low 
(CLKOS)

 1.8 — — ns

tOPJIT
1 Output clock period jitter

fOUT  420 MHz — — 200 ps

420 MHz > fOUT  100 MHz — — 250 ps

fOUT < 100 MHz — — 0.025 UIPP

tSK
Input clock to output clock skew 
when N/M = integer  — — 500 ps

tLOCK
2 Lock time

2 to 25 MHz — — 200 us

25 to 500 MHz — — 50 us

tUNLOCK
Reset to PLL unlock time to 
ensure fast reset  — — 50 ns

tHI Input clock high time 90% to 90% 0.5 — — ns

tLO Input clock low time 10% to 10% 0.5 — — ns

tIPJIT Input clock period jitter  — — 400 ps

tRST

Reset signal pulse width high, 
RSTK  10 — — ns

Reset signal pulse width high, 
RST  500 — — ns

1. Jitter sample is taken over 10,000 samples of the primary PLL output with clean reference clock with no additional I/O toggling.
2. Output clock is valid after tLOCK for PLL reset and dynamic delay adjustment.
3. Period jitter and cycle-to-cycle jitter numbers are guaranteed for fPFD > 4 MHz. For fPFD < 4 MHz, the jitter numbers may not be met in cer-

tain conditions. Please contact the factory for fPFD < 4 MHz. 
4. When using internal feedback, maximum can be up to 500 MHz.
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Figure 3-14. Jitter Transfer – 3.125 Gbps

Figure 3-15. Jitter Transfer – 2.5 Gbps
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Figure 3-24. Power-On-Reset (POR) Timing

Figure 3-25. sysCONFIG Port Timing

CCLK 2

DONE

VCC / VCCAUX /
VCCIO81

CFG[2:0] 3

tICFG

Valid

INITN

tVMC

1.  Time taken from VCC, VCCAUX or VCCIO8, whichever is the last to cross the POR trip point.
2.  Device is in a Master Mode (SPI, SPIm).
3.  The CFG pins are normally static (hard wired).

VCC

CCLK

PROGRAMN

INITN

DONE

DI
GOE Release

DOUT

sysIO

Wake Up Clocks
tSSCH

tSSCL

tCODO      

tIOENSS    

tDPPINIT   

tDINIT   

tICFG tVMC 

tPRGM

tPRGMRJ

tHSCDI (tHMCDI)

tDPPDONE

tIODISS

tSUSCDI (tSUMCDI)



3-56

DC and Switching Characteristics
LatticeECP3 Family Data Sheet

Figure 3-26. Configuration from PROGRAMN Timing

Figure 3-27. Wake-Up Timing
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CFG[2:0] 1

USER I/O

INITN
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tPRGMRJ

t DINIT
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DPPINIT
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Valid

1. The CFG pins are normally static (hard wired)

Master CCLK Output

DONE

VCC

INITN

tMWC tCZ

Bitstream Start

Bitstream End
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Figure 3-28. Master SPI Configuration Waveforms

Figure 3-29. Master SPI POR Waveforms

Opcode Address
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Capture CFGxCapture CR0

Ignore Valid Bitstream

VCC

DONE

INITN
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CSSPIN/CSSPI0N*

SPIFASTN*

CCLK

SISPI

SPID0
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Tcspid
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Pin Information Summary (Cont.)
Pin Information Summary ECP3-95EA ECP3-150EA

Pin Type
484 

fpBGA
672 

fpBGA
1156 

fpBGA
672 

fpBGA
1156

fpBGA

General Purpose 
Inputs/Outputs per bank

Bank 0 42 60 86 60 94

Bank 1 36 48 78 48 86

Bank 2 24 34 36 34 58

Bank 3 54 59 86 59 104

Bank 6 63 67 86 67 104

Bank 7 36 48 54 48 76

Bank 8 24 24 24 24 24

General Purpose Inputs per 
Bank

Bank 0 0 0 0 0 0

Bank 1 0 0 0 0 0

Bank 2 4 8 8 8 8

Bank 3 4 12 12 12 12

Bank 6 4 12 12 12 12

Bank 7 4 8 8 8 8

Bank 8 0 0 0 0 0

General Purpose Outputs per 
Bank

Bank 0 0 0 0 0 0

Bank 1 0 0 0 0 0

Bank 2 0 0 0 0 0

Bank 3 0 0 0 0 0

Bank 6 0 0 0 0 0

Bank 7 0 0 0 0 0

Bank 8 0 0 0 0 0

Total Single-Ended User I/O 295 380 490 380 586

VCC 16 32 32 32 32

VCCAUX 8 12 16 12 16

VTT 4 4 8 4 8

VCCA 4 8 16 8 16

VCCPLL 4 4 4 4 4

VCCIO

Bank 0 2 4 4 4 4

Bank 1 2 4 4 4 4

Bank 2 2 4 4 4 4

Bank 3 2 4 4 4 4

Bank 6 2 4 4 4 4

Bank 7 2 4 4 4 4

Bank 8 2 2 2 2 2

VCCJ 1 1 1 1 1

TAP 4 4 4 4 4

GND, GNDIO 98 139 233 139 233

NC 0 0 238 0 116

Reserved1 2 2 2 2 2

SERDES 26 52 78 52 104

Miscellaneous Pins 8 8 8 8 8

Total Bonded Pins 484 672 1156 672 1156
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Pin Information Summary (Cont.)
Pin Information Summary ECP3-95EA ECP3-150EA

Pin Type 484 fpBGA 672 fpBGA 1156 fpBGA
672 

fpBGA
1156

fpBGA

Emulated 
Differential I/O 
per Bank

Bank 0 21 30 43 30 47

Bank 1 18 24 39 24 43

Bank 2 8 12 13 12 18

Bank 3 20 23 33 23 37

Bank 6 22 25 33 25 37

Bank 7 11 16 18 16 24

Bank 8 12 12 12 12 12

Highspeed 
Differential I/O 
per Bank

Bank 0 0 0 0 0 0

Bank 1 0 0 0 0 0

Bank 2 6 9 9 9 15

Bank 3 9 12 16 12 21

Bank 6 11 14 16 14 21

Bank 7 9 12 13 12 18

Bank 8 0 0 0 0 0

Total Single Ended/ 
Total Differential
I/O per Bank

Bank 0 42/21 60/30 86/43 60/30 94/47

Bank 1 36/18 48/24 78/39 48/24 86/43

Bank 2 28/14 42/21 44/22 42/21 66/33

Bank 3 58/29 71/35 98/49 71/35 116/58

Bank 6 67/33 78/39 98/49 78/39 116/58

Bank 7 40/20 56/28 62/31 56/28 84/42

Bank 8 24/12 24/12 24/12 24/12 24/12

DDR Groups 
Bonded 
per Bank

Bank 0 3 5 7 5 7

Bank 1 3 4 7 4 7

Bank 2 2 3 3 3 4

Bank 3 3 4 5 4 7

Bank 6 4 4 5 4 7

Bank 7 3 4 4 4 6

Configuration 
Bank8 0 0 0 0 0

SERDES Quads 1 2 3 2 4

1.These pins must remain floating on the board.
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Package Pinout Information
Package pinout information can be found under “Data Sheets” on the LatticeECP3 product pages on the Lattice 
website at http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3 and in the Diamond or ispLEVER 
software tools. To create pinout information from within ispLEVER Design Planner, select Tools > Spreadsheet 
View. Then select Select File > Export and choose a type of output file. To create a pin information file from within 
Diamond select Tools > Spreadsheet View or Tools >Package View; then, select File > Export and choose a 
type of output file. See Diamond or ispLEVER Help for more information.

Thermal Management 
Thermal management is recommended as part of any sound FPGA design methodology. To assess the thermal 
characteristics of a system, Lattice specifies a maximum allowable junction temperature in all device data sheets. 
Designers must complete a thermal analysis of their specific design to ensure that the device and package do not 
exceed the junction temperature limits. Refer to the Thermal Management document to find the device/package 
specific thermal values.

For Further Information
For further information regarding Thermal Management, refer to the following:

• Thermal Management document

• TN1181, Power Consumption and Management for LatticeECP3 Devices

• Power Calculator tool included with the Diamond and ispLEVER design tools, or as a standalone download from 
www.latticesemi.com/software

http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3.aspx
www.latticesemi.com/dynamic/view_document.cfm?document_id=210
www.latticesemi.com/dynamic/view_document.cfm?document_id=32321
http://www.latticesemi.com/products/designsoftware/index.cfm


5-3

Ordering Information
LatticeECP3 Family Data Sheet

Part Number Voltage Grade1 Power Package Pins Temp. LUTs (K) 

LFE3-70EA-6FN484C 1.2 V –6 STD Lead-Free fpBGA 484 COM 67

LFE3-70EA-7FN484C 1.2 V –7 STD Lead-Free fpBGA 484 COM 67

LFE3-70EA-8FN484C 1.2 V –8 STD Lead-Free fpBGA 484 COM 67

LFE3-70EA-6LFN484C 1.2 V –6 LOW Lead-Free fpBGA 484 COM 67

LFE3-70EA-7LFN484C 1.2 V –7 LOW Lead-Free fpBGA 484 COM 67

LFE3-70EA-8LFN484C 1.2 V –8 LOW Lead-Free fpBGA 484 COM 67

LFE3-70EA-6FN672C 1.2 V –6 STD Lead-Free fpBGA 672 COM 67

LFE3-70EA-7FN672C 1.2 V –7 STD Lead-Free fpBGA 672 COM 67

LFE3-70EA-8FN672C 1.2 V –8 STD Lead-Free fpBGA 672 COM 67

LFE3-70EA-6LFN672C 1.2 V –6 LOW Lead-Free fpBGA 672 COM 67

LFE3-70EA-7LFN672C 1.2 V –7 LOW Lead-Free fpBGA 672 COM 67

LFE3-70EA-8LFN672C 1.2 V –8 LOW Lead-Free fpBGA 672 COM 67

LFE3-70EA-6FN1156C 1.2 V –6 STD Lead-Free fpBGA 1156 COM 67

LFE3-70EA-7FN1156C 1.2 V –7 STD Lead-Free fpBGA 1156 COM 67

LFE3-70EA-8FN1156C 1.2 V –8 STD Lead-Free fpBGA 1156 COM 67

LFE3-70EA-6LFN1156C 1.2 V –6 LOW Lead-Free fpBGA 1156 COM 67

LFE3-70EA-7LFN1156C 1.2 V –7 LOW Lead-Free fpBGA 1156 COM 67

LFE3-70EA-8LFN1156C 1.2 V –8 LOW Lead-Free fpBGA 1156 COM 67

1. For ordering information on -9 speed grade devices, please contact your Lattice Sales Representative.

Part Number Voltage Grade1 Power Package Pins Temp. LUTs (K) 

LFE3-95EA-6FN484C 1.2 V –6 STD Lead-Free fpBGA 484 COM 92

LFE3-95EA-7FN484C 1.2 V –7 STD Lead-Free fpBGA 484 COM 92

LFE3-95EA-8FN484C 1.2 V –8 STD Lead-Free fpBGA 484 COM 92

LFE3-95EA-6LFN484C 1.2 V –6 LOW Lead-Free fpBGA 484 COM 92

LFE3-95EA-7LFN484C 1.2 V –7 LOW Lead-Free fpBGA 484 COM 92

LFE3-95EA-8LFN484C 1.2 V –8 LOW Lead-Free fpBGA 484 COM 92

LFE3-95EA-6FN672C 1.2 V –6 STD Lead-Free fpBGA 672 COM 92

LFE3-95EA-7FN672C 1.2 V –7 STD Lead-Free fpBGA 672 COM 92

LFE3-95EA-8FN672C 1.2 V –8 STD Lead-Free fpBGA 672 COM 92

LFE3-95EA-6LFN672C 1.2 V –6 LOW Lead-Free fpBGA 672 COM 92

LFE3-95EA-7LFN672C 1.2 V –7 LOW Lead-Free fpBGA 672 COM 92

LFE3-95EA-8LFN672C 1.2 V –8 LOW Lead-Free fpBGA 672 COM 92

LFE3-95EA-6FN1156C 1.2 V –6 STD Lead-Free fpBGA 1156 COM 92

LFE3-95EA-7FN1156C 1.2 V –7 STD Lead-Free fpBGA 1156 COM 92

LFE3-95EA-8FN1156C 1.2 V –8 STD Lead-Free fpBGA 1156 COM 92

LFE3-95EA-6LFN1156C 1.2 V –6 LOW Lead-Free fpBGA 1156 COM 92

LFE3-95EA-7LFN1156C 1.2 V –7 LOW Lead-Free fpBGA 1156 COM 92

LFE3-95EA-8LFN1156C 1.2 V –8 LOW Lead-Free fpBGA 1156 COM 92

1. For ordering information on -9 speed grade devices, please contact your Lattice Sales Representative.
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Date Version Section Change Summary

March 2015 2.8EA Pinout Information
All

Updated Package Pinout Information section. Changed reference to 
http://www.latticesemi.com/Products/FPGAandCPLD/LatticeECP3.

Minor style/formatting changes.

April 2014 02.7EA DC and Switching 
Characteristics

Updated LatticeECP3 Supply Current (Standby) table power numbers.

Removed speed grade -9 timing numbers in the following sections:
— Typical Building Block Function Performance
— LatticeECP3 External Switching Characteristics
— LatticeECP3 Internal Switching Characteristics
— LatticeECP3 Family Timing Adders

Ordering Information Removed ordering information for -9 speed grade devices.

March 2014 02.6EA DC and Switching 
Characteristics

Added information to the sysI/O Single-Ended DC Electrical Character-
istics section footnote.

February 2014 02.5EA DC and Switching 
Characteristics

Updated Hot Socketing Specifications table. Changed IPw to IPD in foot-
note 3.

Updated the following figures:
— Figure 3-25, sysCONFIG Port Timing
— Figure 3-27, Wake-Up Timing

Supplemental 
Information

Added technical note references.

September 2013 02.4EA DC and Switching 
Characteristics

Updated the Wake-Up Timing Diagram

Added the following figures:
— Master SPI POR Waveforms
— SPI Configuration Waveforms
— Slave SPI HOLDN Waveforms 

Added tIODISS and tIOENSS parameters in LatticeECP3 sysCONFIG 
Port Timing Specifications table.

June 2013 02.3EA Architecture sysI/O Buffer Banks text section – Updated description of “Top (Bank 0 
and Bank 1) and Bottom sysIO Buffer Pairs (Single-Ended Outputs 
Only)” for hot socketing information.

sysI/O Buffer Banks text section – Updated description of “Configuration 
Bank sysI/O Buffer Pairs (Single-Ended Outputs, Only on Shared Pins 
When Not Used by Configuration)” for PCI clamp information.

On-Chip Oscillator section – clarified the speed of the internal CMOS 
oscillator (130 MHz +/- 15%).

Architecture Overview section – Added information on the state of the 
register on power up and after configuration.

DC and Switching
Characteristics

sysI/O Recommended Operating Conditions table – Removed refer-
ence to footnote 1 from RSDS standard.

sysI/O Single-Ended DC Electrical Characteristics table – Modified foot-
note 1.

Added Oscillator Output Frequency table.

LatticeECP3 sysCONFIG Port Timing Specifications table – Updated 
min. column for tCODO parameter.

LatticeECP3 Family Timing Adders table – Description column, refer-
ences to VCCIO = 3.0V changed to 3.3V. For PPLVDS, description 
changed from emulated to True LVDS and VCCIO = 2.5V changed to 
VCCIO = 2.5V or 3.3V. 
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